GRADUATE COUNCIL: NEW COURSE PROPOSAL

Originating Unit: Educational Leadership and Higher Education (ELHE)

Type of action: |[] [ New course Full online course**

Semester and year course will take effect: Spring 2024

New course title: Diversity in American Higher Education

Appropriate computer abbreviation (30 spaces or less): Dijversity in American HE
Course instructional methodology: | ecture

course component types: ugradcouncil.tcu.edu/forms/Course Component Types.pdf

New course number: EDHE 61093

Prerequisites for new course: include an attachment if additional space is needed

Admission into the TCU College of Education higher education graduate program.

attached files can be seen and managed in Acrobat Pro by clicking on

Click here to attach a file
View > Show/Hide > Navigations Panes > Attachments




Description of new course (catalog copy): include an attachment if additional space is needed

Admission into the TCU College of Education higher education graduate program. Emphasis is on the interaction
between social identities and institutional, societal, governmental, and personal influences and how these impact
participation and retention of students, faculty, and staff. This course invites students to examine how social identities
are created and the existence of these in relation to societal power structures. By examining power structures, students
will gain a better understanding of how these are replicated within the higher education systems and the effect these
have had on minoritized/marginalized populations. Students will deepen their understanding of and develop their
leadership on historical and contemporary topics related to inclusion, justice, power, and privilege in higher education
settings. Students will assess frameworks and theories that seek to promote equity and justice in education.

Cilhs e o aitme n 2l attached files can be seen and managed in Acrobat Pro by clicking on
View > Show/Hide > Navigations Panes > Attachments




Fully Online Courses**

All online courses, and /or distance learning offerings must meet State Compliance regulations as defined by specific state
legislation. TCU Distance Learning is any for-credit instruction provided to a TCU student outside the State of Texas.
This includes internships, clinical, video conferencing, online, or any other delivery format that crosses state lines.
Contact the Koehler Center for Teaching Excellence for guidelines. Include a letter of support from the Koehler Center
with this proposal.

Supporting evidence or justification: (For a new course, attach proposed syllabus, including course objectives,
course outline, and representative bibliography.)

Describe the intended outcomes of the course and how they will be assessed: include an attachment if
additional space is needed

See attached.

attached files can be seen and managed in Acrobat Pro by clicking on

Sliele nsre b9 g @il View > Show/Hide > Navigations Panes > Attachments

Additional resources required:

Faculty: N/A

Space: N/A

Equipment: N/A

Library: N/A

Financial Aid: N/A

Other: N/A

Change in teaching load: N/A

Does this change affect any other units of the University? Yes || No

If yes, submit supporting statement signed by chair of affected unit.

If cross-listed, provide evidence of approval by all curriculum committees appropriate to both the originating and
the cross-listed units.



Chair of Originating Unit:

Name: Dr. Ashley Tull

Unit: Educational Leadership & Higher Education

Signature: A. M% %



EDHE 61093 Example Learning Outcomes
As a result of participating in this course, students will be able to:

e Reflect upon one’s own social identities and how those identities impact how you
perceive, navigate, and experience the world through readings, written assignments, and
in-class dialogue and activities.

o In-class discussions of readings

o Reflection Paper assignments

o Journal Entry assignments

o Self-Assessment Paper assignment

e Explore how power, privilege, prejudice, discrimination, and oppression manifest
historically and contemporarily in educational settings through readings and in-class
dialogue and activities.

o In-class discussions of readings

Reflection Paper assignments

Journal Entry assignments

Class Discussion Facilitation

o O O

e Analyze theories, frameworks, and historic efforts that have been designed to transform
institutions into equitable and just campuses through readings and in-class dialogue and
activities.

o In-class discussions of readings
o Reflection Paper assignments
o Journal Entry assignments

o Class Discussion Facilitation

o Final Project

e Apply existing frameworks and theories to address power structures in higher education
in your career areas through readings, written assignments, and in-class dialogue.
o In-class discussions of readings
Reflection Paper assignments
Journal Entries assignments
Class Discussion Facilitation
Final Project

o O O O



EDHE 61093: Diversity in American Higher Education

Instructor Name:

Semester and Year:
Number of Credits: 3

Class Location:

Class Meeting Day & Time:
Zoom Access Information: Zoom sessions will be scheduled via D2L, if needed.
Office Location:

Office Hours:

Telephone:

Email:

Response Time:

Final Exam Date & Other Important Dates

Final Exam
There is no formal final exam; rather, there will be a final presentation on XXX.

Course Description

Admission into the TCU College of Education higher education graduate program. Emphasis is
on the interaction between social identities and institutional, societal, governmental, and personal
influences and how these impact participation and retention of students, faculty, and staff. This
course invites students to examine how social identities are created and the existence of these in
relation to societal power structures. By examining power structures, students will gain a better
understanding of how these are replicated within the higher education systems and the effect
these have had on minoritized/marginalized populations. Students will deepen their
understanding of and develop their leadership on historical and contemporary topics related to
inclusion, justice, power, and privilege in higher education settings. Students will assess
frameworks and theories that seek to promote equity and justice in education.

Learning Outcomes

Learning Outcome 1: Reflect upon one’s own social identities and how those identities impact
how you perceive, navigate, and experience the world through readings, written assignments, and
in-class dialogue and activities.

Learning Outcome 2: Explore how power, privilege, prejudice, discrimination, and oppression
manifest historically and contemporarily in educational settings through readings and in-class
dialogue and activities.

Learning Outcome 3: Analyze theories, frameworks, and historic efforts that have been
designed to transform institutions into equitable and just campuses through readings and in-class
dialogue and activities.




Learning Outcome 4: Apply existing frameworks and theories to address power structures in
higher education in your career areas through readings, written assignments, and in-class
dialogue.

Prerequisites
Admission into the TCU College of Education higher education graduate program.
Required Texts/Materials

All readings will be housed within TCU Online/D2L. Along the left-hand side of our course
shell, class readings will be organized by date.

Khalifa, M. (2018). Culturally Responsive School Leadership. Harvard Education Press.

Sensoy, O., & DiAngelo, R. (2017). Is everyone really equal? An introduction to key concepts in
social justice education. New York, NY: Teachers College Press.

Recommended Texts/Materials

In an effort to make the reading load manageable, I did not assign all the possible readings
related to the topics on the course schedule. | chose specific pieces that offer a brief yet
somewhat comprehensive view of the topic. | also selected pieces that were foundational and
even transformational to me personally as well as a learner and educator. As a class, we will
compile a list of other texts related to the topics covered in class. These texts are not required but
can supplement our knowledge of the subject matter. You can access the reading list through this
link: shorturl.at/hkIT6 or by scanning the QR code below.

Teaching Philosophy
XXX

Instructional Methods
XXX


file:///C:/Users/sdcuellar/Desktop/COE/EDAD%2055003/shorturl.at/hklT6

Course Assignments, Point values, and Schedule
Assignments/Grades

Participation: Learning Outcomes 1, 2, 3, and 4

Participation in class discussions and activities will enhance your verbal and listening skills as
well as allow invaluable opportunities to hear different perspectives and learn from your peers.
Participation is imperative to your learning and development, and active engagement is expected
of all students. You are expected to come prepared to class, having read the assigned reading and
being able to participate in class discussions and activities. You will have the opportunity to
reflect upon and critique the readings in and out of class. | would encourage you to be physically,
mentally, and verbally present in class. The more present you are, the more value you will find in
this course. Participation will be evaluated on listening, participation, quality of contributions,
the impact of contributions, and frequency of contributions. Participation will be worth 30% of
your grade. You will get one point for each day you actively participate in class for a total of 15
possible points. Below is the breakdown for the additional 15 possible points. All assignments
should be uploaded to TCU Online/D2L under the Assignments section by the specified due
date.

DATE: Khalifa Event Reflection (5pts)
DATE: Reflection (5pts)
DATE: Dolores Event Reflection (5pts)

Self-Assessment Paper: Learning Outcome 1

The self-assessment paper is a short, reflective essay (1,000-1,250 words (graduate students),
750-1,000 words (undergraduate students), 12-point font, double-spaced, in your format of
choice) that describes your social identities. These papers will not be shared with others and are
meant to provide a safe space for you to reflect and grow. Self-assessment papers should be
uploaded to TCU Online/D2L under the Assignments section on XXX.

You will be evaluated based on your incorporation of the A.D.D.R.E.S.S.I.N.G. model (2
points), an intersectional analysis of your social identities (2 points), acknowledgment of your
privilege and/or power (2 points), an analysis of how privilege and power can change across
space and time (2 points), and demonstrated ability to analyze how social identities impact our
experiences in the world and specifically in the education system (2 points). Your self-
assessment will be worth a total of 10 points.

Journal Entries: Learning Outcomes 1, 2, 3, and 4

This class is grounded in our ability to not only reflect on our readings and class discussions, but
also on our personal connections to the content of this class. Therefore, you will submit two (2)
journal entries throughout the semester. Journal entries should be no more than two (2) pages
(12-point font, double-spaced, in your format of choice). These journal entries are a way in
which you can more privately reflect on this class, your thoughts, questions, challenges you may



be having as you make sense of the material, and even emotions that may surface as you learn,
etc. These journals will also help me assess your learning. Journal entries should be uploaded to
TCU Online/D2L under the Assignments section by 11:59 PM on the dates below. For the first
journal entry, you will be evaluated based on the thoughtfulness of your reflection (5 points),
your exploration of how inequity and injustice both historically and contemporarily in education
(5 points), and your incorporation of at least three (3) in-class readings or materials (5 points).
For your second journal entry, you will be evaluated based on your analysis of theories,
frameworks, and/or historic efforts that have impacted justice and equity in education (5 points),
your contemplation of how such theories and frameworks can be used to address injustices in
your future careers (5 points), and your incorporation of at least three (3) in-class readings or
materials (5 points). Be sure to properly cite all sources. Each response will be worth a total of
15 points.

DATE: Journal Entry #1
DATE: Journal Entry #2

Leading Class Discussion: Graduate Students Only: Learning Outcomes 2, 3, and 4

Each graduate student will be asked to present on assigned supplemental materials. The semester
calendar will denote each opportunity for a graduate student presentation. Graduate students
should engage with the corresponding supplemental material and prepare a presentation for the
class. Students must provide a tangible presentation of materials (e.g., a one-page summary, a
PowerPoint presentation, a Canva graphic) (3 points). Please send your materials to me prior to
class, so I can upload them to TCU Online/D2L for everyone to access. You will be asked to
provide no more than a 10-minute overview/summary/response to the material (2 points). Your
presentation should incorporate at least three topics we have discussed in class (3 points) and
pose one question or activity that allows students to further engage with the material (2 points).

Final Project: Learning Outcomes 3 and 4

The final project is intended to be an activist/advocacy effort you execute. Too often, we stop at
identifying and perhaps naming a problem. However, being able to identify issues, advocate for
solutions, and/or implement tangible plans for improvement is imperative. Throughout the
semester, you will have the opportunity to identify inequities and injustices throughout K-12 and
higher education as well as brainstorm ways to improve higher education for marginalized
populations. For your final project, you will work in groups to address a specific issue within the
education system that impacts minoritized/marginalized individuals. This can be anywhere from
rearranging a classroom to increase accessibility to starting a social media campaign to increase
awareness. You will be evaluated on your articulation of the issue both historically and
contemporarily (5 points), your analysis of who is impacted by the issue (be sure to think
intersectionally; 5 points), your solution to address the issue (what did you do?; 5 points), and
your contemplation of what still needs to be done (5 points). You will present your project as a
group on Wednesday, May 3. Please be sure everyone plays an active part in both the project
execution and the presentation. Please upload your presentation or a link to it on TCU
Online/D2L under Assignments. Only one person from each will need to upload your project.



Grading

Final Grade Elements / Grade Breakdown

Outcome(s) Assignments and Presentations Percentage | Points
1,2,3,4 Participation 30% 30
1 Self-Assessment 10% 10
2,3, 4 Leading Class Discussion 10% 10
1,2,3,4 Journal #1 15% 15
1,2,3,4 Journal #2 15% 15
3,4 Final Project 20% 20




Course Schedule

Week

Focus

*Materials to be read/watches/reviewed
prior to class*
All materials are on TCU Online/D2L

In-Class Activities |
All Assignments
Due at 11:59PM

Introductions
Community Agreement
Resources

Review: Course syllabus

Social Identities and
Intersectionality

Read: Mapping the Margins
Review: A.D.D.R.E.S.S.I.N.G Table

Unconscious Bias
Training TBD

Justice in Education

Read: Sensoy & DiAngelo - Preface &
Chapter 1

Oppression and Critical Self-
Reflection

Read: Khalifa - Introduction, Chapter 1,
& Chapter 2

Green Chair Speaker:
Dr. Muhammad Khalifa

Self-Assessment Due

Event Reflection Due

Politics of Bodies and Space

Identity Confluence

Read: Khalifa - Chapters 3 & 4

Example Presentation

Pedagogy and Curriculum

School-Community Relations

Read: Khalifa - Chapters 5 & 6

Asynchronous Class
Meeting

Reflection Due

Critical Thinking and
Theory

Read: Sensoy & DiAngelo - Chapter 2

Graduate Students:
Watch: Precious Knowledge via TCU
Kanopy

Student Presentation

Culture and Socialization

Prejudice and Discrimination

Read: Sensoy & DiAngelo - Chapter 3 &
4

Graduate Students:
Watch: Fattitude via TCU Kanopy

Student Presentation

Journal #1 Due

Oppression and Power

Read: Sensoy & DiAngelo - Chapter 5

Graduate Students:
Watch: Missing and Murdered
Indigenous Women Docuseries

Student Presentation

Sexism Read: Sensoy & DiAngelo - Chapter 7 Speaker/Event:
Dolores Huerta
Graduate Students:
Watch: Dolores Huerta Student Presentation
Event Reflection Due
Ableism Read: Sensoy & DiAngelo - Chapters 6 Student Presentation

Graduate Students:



https://we.riseup.net/assets/139021/versions/1/crenshaw%20intersectionality.pdf
https://www.semanticscholar.org/paper/Integrating-evidence-based-practice%2C-therapy%2C-and-Hays/9d1b652d74082e8b7ba3899ca7fb7cc69772f10a/figure/0
https://www.kanopy.com/en/tcu/video/155997
https://www.kanopy.com/en/tcu/video/10871400
https://projects.seattletimes.com/2019/mmiw/
https://projects.seattletimes.com/2019/mmiw/
https://www.pbs.org/independentlens/documentaries/dolores-huerta/

Listen: The Intersections of Disability

Racism & White Supremacy

Read: Sensoy & DiAngelo - Chapters 8 &
9

Graduate Students:
Watch: White Like Me via TCU Kanopy

Student Presentation

Journal #2 Due

Classism

Read: Sensoy & DiAngelo - Chapter 10

Graduate Students:
Watch: Being Poor via TCU Kanopy

Student Presentation

Social Justice in Action

Read: Sensoy & DiAngelo - Chapters 11
& 12

Graduate Students:
Read: We Demand Introduction

Student Presentation

Advocacy and Activism

Project Presentations

Course Policies and Requirements

Grading Scale

Grade | Score Grade | Score
A 94-100 B- 80-83
A- 90-93 C+ 77-79
B+ 87-89 C 74-76
B 84-86 C- 70-73

Grades below a “D” are not allowed in graduate courses.

Late Work

All assigned work is due on the date and by the time indicated in the syllabus. Late work will be
deducted two points for every day late. Late work for full credit will only be accepted if the
absence is due to an Official University Absence. Faculty are required to permit students to make
up work missed because of Official University Absences. Weekly attendance and participation

are included in the final grade.

Grading Concerns

If you are concerned about a grade received on an assignment, please send me a written request,
in the form of an email, addressing the grade, your concerns, and any supporting information
pertaining to the situation. This written request should be submitted within one week of receiving

the grade.

Attendance



https://go.southernct.edu/realtalk/episodes-list/the-intersections-of-disability/
https://www.kanopy.com/en/tcu/video/93031
https://www.kanopy.com/en/tcu/video/11239512
https://www.jstor.org/stable/10.1525/j.ctv1xxt2q.4#metadata_info_tab_contents

You are expected to attend every class meeting. Regular and punctual class attendance is
essential for academic success and no assigned work is summarily excused because of absence
regardless of the cause.

Class will begin promptly at the designated time, and students are expected to be ready to begin
class at that time. If circumstances prevent you from attending class or arriving on time, please
send me an e-mail (christine.hall@tcu.edu) or leave a voicemail [(817) 257-6778] as a
professional courtesy. After an absence, it is the student’s responsibility to follow-up with
classmates for information missed.

Faculty are required to permit students to make up work missed because of Official University
Absences. If a student misses a class because of an Official University Absence, make-up work
will be assigned.

Students are given one absence (for any reason). After one absence, students will lose points in
their attendance, preparation, and participation grade.

Participation

Sharing ideas, discussing opinions, and interpreting readings with your peers is an important part
of graduate education. It is expected that all readings and assignments are completed prior to the
start of class so that you may fully engage in conversations and presentations. Additionally, class
participation is instrumental to not only your learning and development but also the learning and
development of your colleagues. Active engagement is expected of graduate students.
Participation will be evaluated on quality, impact, and frequency of contributions as well as
active listening. Additional information regarding participation is outlined in the Assignments
section of the syllabus.

Class Norms & Netiquette

All members of the class are expected to follow rules of common courtesy in all email messages,
discussions, and chats. If I deem any of them to be inappropriate or offensive, | will forward the
message to the Chair of the department and appropriate action will be taken, not excluding
expulsion from the course. The same rules apply online as they do in person. Be respectful of
other students. Foul discourse will not be tolerated. Please take a moment and read some basic
information about netiquette (http://www.albion.com/netiquette/).

Participating in the virtual realm, including social media sites and shared-access sites sometimes
used for educational collaborations, should be done with honor and integrity. Please review the
relevant sections of the Student Handbook (https://deanofstudents.tcu.edu/student-handbook/) for
TCU’s network and computing policies and communication guidelines.

Technology Policies

We live in a technologically connected world. Many of you have families and job responsibilities
outside of this class, and you may have issues arise during class time. However, surfing social
media, being distracted by items that are not related to class content, and general misuse of
technology during class will not help you learn, and is disrespectful to your classmates,
instructors, and any guests


mailto:christine.hall@tcu.edu
http://www.albion.com/netiquette/
http://www.albion.com/netiquette/
http://www.albion.com/netiquette/
https://deanofstudents.tcu.edu/student-handbook/
https://deanofstudents.tcu.edu/student-handbook/

Unless a student is on-call with their assistantship, students are not to use cell phones for calls or
texts during class. Students may use technology in the classroom as needed to meet the course
learning outcomes. Technology should not be used excessively or for work that is unrelated to
the class discussion or assignments. Students are encouraged to not use technology during class
discussions in order to fully focus on the facilitator and dialogue.

I will address any issues with individual students. Please be present and engaged during each
class.

E-mail
Only the official TCU student email address will be used for all course notification. It is your
responsibility to check your TCU email on a regular basis.

Course Materials

TCU students are prohibited from sharing any portion of course materials (including videos,
PowerPoint slides, assignments, or notes) with others, including on social media, without written
permission by the course instructor. Accessing, copying, transporting (to another person or
location), modifying, or destroying programs, records, or data belonging to TCU or another user
without authorization, whether such data is in transit or storage, is prohibited. The full policy can
be found at: https://security.tcu.edu/polproc/usage-policy/.

Violating this policy is considered a violation of Section 3.2.8 of the Student Code of

Conduct found in the Student Handbook (https://deanofstudents.tcu.edu/student-handbook/), and
may also constitute Academic Misconduct or Disruptive Classroom Behavior. TCU

encourages student debate and discourse; accordingly, TCU generally interprets and applies its
policies, including the policies referenced above, consistent with the values of free expression
and First Amendment principles.

Academic Misconduct

Academic Misconduct (Section 3.4 of the Student Code of Conduct found in the Student
Handbook (https://deanofstudents.tcu.edu/student-handbook/)): Any act that violates the
academic integrity of the institution is considered academic misconduct. The definitions and
procedures used to resolve suspected acts of academic misconduct are available in the offices of
the Academic Deans and Dean of Students, and are also listed in detail in the Undergraduate
Catalog (http://tcu.smartcatalogig.com/current/Undergraduate-Catalog/Student-
Policies/Academic-Conduct-Policy-Details) and the Graduate Catalog
(http://tcu.smartcatalogig.com/en/current/Graduate-Catalog/Academic-Conduct).

Specific examples include, but are not limited to:

e Cheating: Copying from another student’s test paper, laboratory report, other report, or
computer files and listings; using, during any academic exercise, material and/or devices
not authorized by the person in charge of the test; collaborating with or seeking aid from
another student during a test or laboratory without permission; knowingly using, buying,
selling, stealing, transporting, or soliciting in its entirety or in part, the contents of a test
or other assignment unauthorized for release; substituting for another student or
permitting another student to substitute for oneself.


https://security.tcu.edu/polproc/usage-policy/
https://deanofstudents.tcu.edu/student-handbook/
https://deanofstudents.tcu.edu/student-handbook/
https://deanofstudents.tcu.edu/student-handbook/
https://deanofstudents.tcu.edu/student-handbook/
https://deanofstudents.tcu.edu/student-handbook/
http://tcu.smartcatalogiq.com/current/Undergraduate-Catalog/Student-Policies/Academic-Conduct-Policy-Details
http://tcu.smartcatalogiq.com/current/Undergraduate-Catalog/Student-Policies/Academic-Conduct-Policy-Details
http://tcu.smartcatalogiq.com/current/Undergraduate-Catalog/Student-Policies/Academic-Conduct-Policy-Details
http://tcu.smartcatalogiq.com/current/Undergraduate-Catalog/Student-Policies/Academic-Conduct-Policy-Details
http://tcu.smartcatalogiq.com/en/current/Graduate-Catalog/Academic-Conduct
http://tcu.smartcatalogiq.com/en/current/Graduate-Catalog/Academic-Conduct

e Plagiarism: The appropriation, theft, purchase or obtaining by any means another’s work,
and the unacknowledged submission or incorporation of that work as one’s own offered
for credit. Appropriation includes the quoting or paraphrasing of another’s work without
giving credit therefore.

e Collusion: The unauthorized collaboration with another in preparing work offered for
credit.

e Abuse of resource materials: Mutilating, destroying, concealing, or stealing such
material.

e Computer misuse: Unauthorized or illegal use of computer software or hardware through
the TCU Computer Center or through any programs, terminals, or freestanding computers
owned, leased, or operated by TCU or any of its academic units for the purpose of
affecting the academic standing of a student.

e Fabrication and falsification: Unauthorized alteration or invention of any information or
citation in an academic exercise. Falsification involves altering information for use in any
academic exercise. Fabrication involves inventing or counterfeiting information for use in
any academic exercise.

e Multiple submission: The submission by the same individual of substantial portions of
the same academic work (including oral reports) for credit more than once in the same or
another class without authorization.

e Complicity in academic misconduct: Helping another to commit an act of academic
misconduct.

e Bearing false witness: Knowingly and falsely accusing another student of academic
misconduct.

Student Perception of Teaching (SPOT)

Towards the end of the term, you will receive an email asking you to complete your SPOT for
this course. | appreciate your thoughtful and reflective feedback to help make this course
successful for future students. You can fill out the SPOT by clicking on the link in the email or in
TCU Online when SPOTSs open.

TCU Mission Statement
To educate individuals to think and act as ethical leaders and responsible citizens in the global
community.

College of Education Mission Statement
To prepare exemplary leaders for diverse educational settings and related fields who are
reflective, ethical, innovative, and committed to all learners.

TCU Online: Our Learning Management System
Getting Started with TCU Online

Technical Requirements: Check your computer is ready by looking at the specifications list.
(https://community.brightspace.com/s/article/Brightspace-Platform-Requirements)

Log In: (using your TCU Network Credentials)
Option 1: Access via my.tcu.edu > Student Quick Links > TCU Online
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https://community.brightspace.com/s/article/Brightspace-Platform-Requirements
https://community.brightspace.com/s/article/Brightspace-Platform-Requirements
http://my.tcu.edu/

Option 2: Login at http://d2l.tcu.edu
*For information about logging into TCU Online, view these instructions
(http://tcuonline.tcu.edu/kb/how-do-i-log-in/).

Student Orientation Tutorial for TCU Online: If you have not yet taken the TCU Online
Student Orientation Tutorial, please do so now. To access it, click on the Orientations semester
OR view all courses in your My Courses widget visible upon logging in to TCU Online. Click on
the "Student Orientation Tutorial” to enter the orientation course. Follow the instructions in the
course. You can return to this tutorial at any time.

How This Course Will Use TCU Online

TCU Online (or D2L) will be used to post announcements, course documents, and some course
readings. If needed, online discussions will be facilitated via TCU Online. Students will upload
all their assignments to TCU Online. This is also where grades will be posted.

Getting Help with TCU Online
If you experience any technical problems while using TCU Online, please do not hesitate to
contact the D2L HELP DESK. They can be reached by phone or chat 24 hours a day, 7 days a
week, 365 days a year.

e Phone: 1-877-325-7778

e Chat: Chat is available within TCU Online in the Help menu on the navigation bar.

If you are working with the helpdesk to resolve a technical issue, make sure to keep me updated
on the troubleshooting progress.

If you have a course-related issue (course content, assignment troubles, quiz difficulties) please
contact me.

Personal Settings & Notifications for TCU Online

As a student, you should set up your account settings, profile, and notifications. To do this you
will login to TCU Online and select your name on the top right of the screen. You can upload a
photo of yourself and add personal information to your profile. In the notifications area, you can
add your phone number to receive text messages when grades are given, as well as reminder
texts for upcoming assignments and quizzes.

Student Success Tools for TCU Online

Pulse

Pulse is a phone app which gives you access to the course calendar, assignments, grades, and
announcements. This app provides a graph that can help you manage your time. Based on the
number of assignments and events on the course calendar for your classes, the graph will display
busy times for class work in the upcoming week. You can use this app to manage your daily
workload, and it includes the ability to view and access course materials offline. You can
download Pulse from the Google Play or Apple Store. You can learn more and download Pulse
here: https://www.d2l.com/products/pulse/.

ReadSpeaker
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http://d2l.tcu.edu/
file:///C:/Users/HallF/Downloads/instructions
http://tcuonline.tcu.edu/kb/how-do-i-log-in/
https://www.d2l.com/products/pulse/
https://www.d2l.com/products/pulse/

ReadSpeaker includes a number of tools that can enhance your understanding and
comprehension of course materials. ReadSpeaker can create an audio version of content that you
can listen to while on a page within a course or that you can download to listen offline.
ReadSpeaker can also read Microsoft Office files and PDFs. There are additional tools and
features to assist you with reading and focusing on TCU Online, tools that provide support for
writing and proofing text, and tools that can read non-TCU Online content aloud. You can learn
more about how to use ReadSpeaker tools here: https://tcuonline.tcu.edu/how-to-hub/instructor-
how-to-hub-for-tcu-online/integrations-and-mobile/readspeaker/

Support for TCU Students

Campus Offices

e Academic Advising (817-257-7486, Jarvis 104)
Brown-Lupton Health Center (817-257-7938 or 817-257-7940)
Center for Digital Expression (CDeX) (cdex@tcu.edu, Scharbauer 2003)
Center for Writing (817-257-7221, Reed Hall 419)
Counseling & Mental Health Center (817-257-7863, Jarvis Hall 2" floor)
Dean of Students (817-257-7926, the Harrison 1600)
Mary Couts Burnett Library: Reference Desk (817-257-7117)
Office of Religious & Spiritual Life (817-257-7830, Jarvis Hall 1% floor)
Student Access & Accommodations (817-257-6567, The Harrison 1200)
Student Success (817-257-8345, Samuelson Hall, West Entrance)
Substance Use and Recovery Services (817-257-7100, Jarvis Hall 2" floor)
Transfer Student Center (817-257-8345, Samuelson Hall, West Entrance)
Veterans Services (817-257-5551, Jarvis Hall 2" floor)

Anti-Discrimination and Title IX Information

Statement on TCU’s Non-Discrimination Policy

TCU is committed to providing a positive learning, living, and working environment free from
unlawful discrimination, harassment, sexual misconduct, and retaliation. In support of this
commitment, in its policy on Prohibited Discrimination, harassment, sexual misconduct and
retaliation, TCU has a range of prohibited behaviors, including unlawful discrimination and
harassment and related sexual and other misconduct based on age, race, color, religion, sex,
sexual orientation, gender, gender identity, gender expression, national origin, ethnic origin,
disability, predisposing genetic information, covered veteran status, and any other basis protected
by law. The Office of Institutional Equity (OIE) is responsible for responding to all reports of
discrimination, harassment, sexual misconduct, and retaliation.

Please use the following links to review TCU Policy 1.008 Prohibited Discrimination,
Harassment, Sexual Misconduct and Retaliation or to review TCU Policy 1.009 Responding to
Reports of Prohibited Discrimination, Harassment, Sexual Misconduct, and Retaliation.

To make a report, you may call OIE at 817-257-8228, email oie@tcu.edu, visit us at The
Harrison, Suite 1800 or click here: Make a Report.
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To learn about the Campus Community Response Team (CCRT) and Report a Bias Incident
click here: https://inclusion.tcu.edu/campus-community-response-team/

Title IX

TCU’s Title IX Coordinator works within OIE. Andrea Vircks-McDew serves as TCU’s Title IX
Coordinator. You may call 817-257-8228 to make a report, email oie@tcu.edu or
a.vircks@tcu.edu, or make a report here. Additional Title IX resources and information are
available at https://www.tcu.edu/institutional-equity/title-ix/index.php.

Mandatory Reporters

ALL TCU employees, except confidential resources, are considered Mandatory Reporters.
Mandatory reporters are required to immediately report to OIE any conduct that raises
Discrimination, Harassment, Sexual Misconduct (Title IX or Violence Against Women
(VAWA)) or Retaliation. Mandatory reporters cannot promise to refrain from forwarding the
information to OIE.

Confidential On-Campus Resources
e Campus Advocacy, Resources & Education
https://care.tcu.edu | 817-257-5225
e Counseling & Mental Health Center
www.counseling.tcu.edu | 817-257-7863
e Religious & Spiritual Life
www.faith.tcu.edu | 817-257-7830

On-Campus Resources
TCU Police
www.police.tcu.edu | 817-257-8400 Non-emergency | 817-257-7777 Emergency

TCU Policy for Religious Observations & Holidays

“Students who are unable to participate in a class, in any related assignment or in a university
required activity because of the religious observance of a holy day shall be provided with a
reasonable opportunity to make up the examination or assignment, without penalty, provided that
it does not create an unreasonable burden on the University.” For more information, please visit
the TCU Policy for Religious Observations & Holidays webpage.

Student Access and Accommodation

Texas Christian University affords students with disabilities reasonable accommodations in
accordance with the Americans with Disabilities Act and Section 504 of the Rehabilitation Act.
To be eligible for disability-related academic accommodations, students are required to register
with the TCU Office of Student Access and Accommodation and have their requested
accommodations evaluated. If approved for accommodations, students are required to discuss
their official TCU Notification of Accommodation with their instructors. Accommodations are
not retroactive and require advance notice to implement. The Office of Student Access and
Accommodation is located in The Harrison, Suite 1200. More information on how to apply for
accommodations can be found at https://www.tcu.edu/access-accommodation/ or by calling
Student Access and Accommodation at (817) 257-6567.
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Audio Recording Notification

Audio recordings of class lectures may be permitted by the instructor or as an approved disability
accommodation through Student Access and Accommodation. Recordings are not to be shared
with other students, posted to any online forum, or otherwise disseminated.

Emergency Response Information

e View TCU’s L.E.S.S. is More public safety video to learn about Lockdown, Evacuate,
and Seek Shelter procedures. (https://publicsafety.tcu.edu/less-is-more/)

e View the TCU Building Safety Maps that show the specific seek shelter locations and
building rally points for evacuation. (https://publicsafety.tcu.edu/less-safety-maps/)

e View the TCU Evacuation Rally Point Map to see all rally points for evacuation.
(https://publicsafety.tcu.edu/wp-content/uploads/2020/01/TCU-Rally-Point-Map.pdf)

e Download the Frogshield Campus Safety App on your phone.
(https://police.tcu.edu/frogshield/).

¢ Inthe event of an emergency, call the TCU Police Department at 817-257-7777.

Native American Land Acknowledgement

As a university, we acknowledge the many benefits we have of being in this place. It is a space
we share with all living beings, human and non-human. It is an ancient space where others have
lived before us. The monument created jointly by TCU and the Wichita and Affiliated Tribes
reminds us of our benefits, responsibilities, and relationships. We pause to reflect on its words:

This ancient land, for all our relations.
We respectfully acknowledge all Native American peoples who have lived on this land since

time immemorial. TCU especially acknowledges and pays respect to the Wichita and Affiliated
Tribes, upon whose historical homeland our university is located.
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